
GENERAL CLUB MEETING   
7:00 P.M. 

4th Wednesday of the month at the  
Midland Community Center 

2001 George St., Midland,  MI 
 
This month’s date:   
August 24, 2011 
 
This month’s topic:  
Club Picnic—Please bring 
dish to pass. Club will 
provide subs, pop and table 
service.  
 
What you missed!   
May meeting: Facebook: the good, bad & ugly -  
presented by Shirley Salas 
 
Upcoming Activities:   
September meeting - Ann Jarvis from Grace A. 
Dow Memorial Library will present information 
on eBooks and how to access Library resources 
via the internet.  
 
Program Coordinators 
Howard Lewis  lewis3ha@chartermi.net  

Bill Tower stressed@tir.com 
 
Please let Howard or Bill know of topics you would 
like covered at future meetings.  
 

President Piper’s Ponderings 
August is the Club picnic, same place, 
same time (7:00 pm). Bring a dish to 
pass and the Club will provide subs, 
pop and table service. 
 

This is the month that all club 
presidents traditionally write their rah-
rah newsletter about the upcoming 
season: the great planned speakers 
and some new ideas and/or projects to try. While this is 
also true for our Club, I would be remiss for not 
recognizing that all these good meetings and ideas have 
taken place without any input or help from me. Perhaps 
the real message of this letter is that Presidents are not 
really necessary for the functioning of a Club if you have 
active members. 
 

I have been running up the Medicare bills the past couple 
months, and my active Club participation will be 
problematical for the next couple months. In my absence 
the Club minions have scheduled: 
Sep   Ann Jarvis from the Midland Library 
Oct    Howard and Carol will speak on Skype 
Nov   Joe will do a Tech Update 
Dec   Christmas Party 
 

I would like to leave you with three miscellaneous 
thoughts. First, I heard a suggestion that, with the 
changing face of technology, perhaps we should change 
the direction and even our name to the Midland 
Technology Club. That should open the range of possible 
monthly meeting topics. Think about it.  
 

Secondly, the leadership of the Senior Center at the 
Community Center has changed; we will have to forge 
new bonds to continue our good working relationship with 
them.  
 

Finally, like last August, I would like to propose we again 
hold another ‘junk’ meeting in conjunction with our picnic. 
You bring in your no longer used electronic stuff to either 
give away or put a price on it for other members to buy. 
Your children and grand children will thank you when they 
have to clean out your house!  
 
(The above comments are the opinion of the author and 
do not necessarily reflect the views of the Midland 
Computer Club.) 
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2011 MCC  OFFICERS 
President     Larry Piper  larryP56@chartermi.net 
Vice Pres.    Joe Lykowski joseph@lykowski.com 
Treasurer    Laura Hammel Lhammel@gmail.com 
Membership  Gary Ensing btiger6@gmail.com 
Editor 
Webmaster  
 

            Special Interest Groups: 
 

PROGRAM COORDINATORS 
Howard Lewis lewis3ha@chartermi.net  
Bill Tower stressed@tir.com 
 

BOARD MEMBERS 
Shirley Salas  
 

PUBLICITY 
Al Adams aladams12@yahoo.com  
 

http://mcc.apcug.org/  

    Membership  Enrollment  Form        
 
       NAME  _______________________________________           PHONE  __________________ 
 
       ADDRESS  ___________________________________________________   
 
       CITY    __________________              ZIP  _______________       
 
        EMAIL ADDRESS     ___________________________________________ 
 
       Membership dues   FAMILY ($20)      STUDENT ($15)     New Member ____    Renewal   ____ 
 
                     Please fill out the above form and mail it along with payment of check or money order to : 
 
           MIDLAND COMPUTER CLUB         Attn: Memb ership Chairman 
              1816 Bauss Ct 
             Midland, MI  48642-4023   
                                                                      You may also pay for membership at a regular club meeting 

Board Meeting 
Next board meeting will be  
7 p.m., September 13, 2011, at  
Chapel Lane Presbyterian Church,  
5501 Jefferson Ave., Midland MI 

Useful, useless and strange (in no particular or-
der) Web Sites:  
 
http://saferproducts.gov/ 
This is a new site by the Consumer Products Safety 
Commission to allow customers to report unsafe 
products. Following procedures set up by the law, 
CPSC will review all online Reports and have five 
business days to transmit qualifying Reports to the 
manufacturer, where practicable. Manufacturers 
then have 10 business days during which they may 
respond and provide comments and/or claims. At 
the end of the 10 day period, if all requirements are 
met, the Report and the manufacturer’s comments 
will be posted on the website. 
 
http://www.teachparentstech.org/ 
If you have someone who needs a little help with 
computer basics, this site has some videos that you 
can email to them to help them get started. Although 
the site looks like it is targeting your parents, you 
really can send this to anyone for some basic help. 
 
http://tinyurl.com/69ujzyWant to know what your 
hard drive is trying to tell you? This site has sounds 
from many different hard drives that are in the pro-
cess of failing and may help you identify what ithe 
problem is.  
 
http://tinyurl.com/28bpznj 
This is a very good article on how to make your 
passwords easy to remember, but difficult to crack. 

Carol Picard   webbyte@yahoo.com 
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Tips, Tricks & Techniques  
 
Malware Removal  
Recently I had a phone call from someone who said that their computer appeared to be infected with a 
virus. This person had been to a website and suddenly a popup appeared that looked like it came from 
Windows saying the computer was infected and she needed to do an emergency scan. She knew not to 
let it do the scan, so she clicked “Cancel”. Immediately all sorts of strange things started to happen. 
(Lesson  – Never click on a popup from a website, unless you are expecting it.) She closed down her 
browser, but could not run any programs. If she tried to run Microsoft Word, Windows told her it could not 
be found. If she tried to run Internet Explorer, it could not be found. If she tried to run McAfee, it could not 
be found. She had tried rebooting Windows, but to no avail. All this time, popups continued to appear 
telling her the computer was infected. Something was obviously wrong with her computer. 
 
I immediately downloaded the latest versions of MalwareBytes, SuperAntiSpyware, and Ccleaner on my 
USB drive and headed for her place. When I inserted the USB drive in her computer, Windows recognized 
the drive and I could see the files. But I couldn’t run SuperAntiSpyware. After browsing the Internet on my 
laptop, I discovered that some of the malware these days is changing the Windows Registry so that 
Windows won’t run any executables and the recommendation was to grab a copy of 
HKEY_CLASSES_ROOT/exefile/shell/open/command from a known good computer (i.e., my laptop since 
both were running Windows 7) and merging it into the registry of the infected computer. After putting that 
on my USB drive, I found I could not do the merge. I then removed the .reg extension from my USB drive, 
tried to run it and when Window asked what to do, put the .reg extension back on. At this point, Windows 
succeeded in merging the key into the registry. Suddenly, things began to work again, but the machine 
was still infected. So I ran SuperAntiSpyware and found one trojan. After SuperAntiSpyware removed that 
trojan, We then reran McAfee which declared her machine clean. 
 
The lesson learned from this experience is that sometimes you have to think “out of the box” and try 
unusual approaches. Malware is getting to be very sophisticated and you need to be extra careful when 
browsing the Internet. Even though this woman knew not to run things when on the Internet, just clicking 
on the page initiated the process. 
 
 
Speedup Windows Startup 
All current versions of Windows (XP, Vista, and 7) load a couple hundred fonts when you start up your 
computer. Also, most word processing applications also add a significant number of fonts. If you use only 
a few fonts, you can speed up the load time for Windows by removing some of those fonts. Usually the 
simplest and safest process is to simply move them to another folder. That will still make them available in 
case you need them later, but they will not be available during the Windows startup procedure or in your 
applications. 
 

 
 
 
Articles in this Newsletter have been obtained from APCUG with the authors’ permission for publication by 
APCUG member groups. The Midland Computer Club has not verified the information contained in the 
articles nor tested procedures/recommended software. Articles do not necessarily reflect the views of the 
Midland Computer Club 
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The Killer App of the 21 st Century 
By Vinny LaBash, Contributing Columnist, Sarasota PCUG, Florida, labash (at) spcug.org 
June 2011 issue, Sarasota PC Monitor, www.spcug.org 
 
Over the years, and more than once, my wife has said “Until computers work the way they do on Star 
Trek, they are not ready for prime time”. She has a point. While computers, smart phones, laptops, 
tablets, and other close relatives of PCs have certainly become ubiquitous in our society, they are among 
the most complex devices ever developed by human beings. Their internal complexity rivals that of the 
most advanced F-22 fighter planes. No one expects grandma to climb into the cockpit of one of these 
things and be an expert after a few lessons because no one expects an F-22 fighter to be easy to use.  
 
Despite what you have been hearing for years, computers are not easy to use, and they are anything but 
intuitive. If Isaac Newton were suddenly transported from the 17th century to the present and handed a 
smart phone, he would have no idea what to do with it. The ability to make a computer do something 
useful has nothing to do with intelligence and everything to do with familiarity. Twelve year olds have no 
problems with smart phones or other devices controlled by microchips because these objects have always 
been a part of their young lives. Most adults have not enjoyed a similar advantage, and many feel that 
technology often works against them.  
 
The problem is that people have had to adjust to the needs of technology rather than the other way 
around. That is the basis of my wife’s complaint about computers. She thinks they should adjust to her,  
and I believe she is right. In the 1982 movie “Firefox”, Clint Eastwood played a character sent on a covert 
mission to the Soviet Union to steal an advanced aircraft that could be controlled by the pilot’s thoughts 
through a neural link. This was and still is science fiction, but it’s also a good example of digital technology 
adjusting to the needs of analog beings like us.  
 
The “Killer App” of the 21st century will be a tool that makes computers and other complex devices adapt 
to us. It already exists, but it’s still in its infancy or perhaps even its embryonic stage. Wherever it is on the 
evolutionary scale, it has not yet moved much beyond the multi-cellular level. We’re talking about present 
day speech recognition, a considerable distance from Star Trek where machines understand natural 
language and react to it as another person would.  
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Windows 7 has speech recognition built-in. You don’t have to pay extra for it. Using it can be quite 
entertaining as well as educational. Set it up on your computer with a three step process accessed within 
Windows Control Panel. You will need either a stand-alone microphone or one attached to a headset. The 
headset-microphone combination is the better option. It’s comfortable, and the headset filters out 
extraneous noise better than most standalone mikes.  
 
It’s tempting to get started quickly, but to get the best results you need to setup your microphone properly. 
Access the Configure Your Speech Recognition  dialog box, and select Set up Microphone . Tell 
Windows what kind of microphone you’re using and the Setup Wizard  will tell you how to position your 
equipment and set your audio level.  
 
Now comes the hard part. Bring up the Configure Your Speech Recognition  dialog box again and 
select Train Your Computer to Understand You . The Wizard will now guide you through some phrases 
which give Windows the information it needs to understand how to interpret and execute your commands. 
Training the computer may be annoying, but it is nowhere near as irritating as trying to get your dog to 
fetch, heel, roll over, and play dead.  
 
Microsoft has thoughtfully provided a reference card which explains how you tell Windows to handle 
common speech recognition commands, keyboard shortcuts, punctuation marks, and other special 
characters. You can print it out from the Control Panel’s Speech Recognition  dialog box. Windows will 
not respond to “Go jump in the Lake”, nor will it attempt to perform any anatomically impossible acts. Keep 
your requests reasonable, and Windows will get along with you just fine.  
 
Smart phones are also getting into the voice activation business. Newer Android models have a neat 
application that does some very useful things. Google Voice Search is nothing short of amazing. I spoke 
into my recently purchased Android driven HTC Thunderbolt “Pictures of Ringling Causeway Bridge” and 
the result was four pictures of the bridge, including a map of how to get there from my Sarasota location.  
 
I then tried “How far from the earth is the Moon?”  This brought up a selection of web sites, one informing 
me of the distance in miles, and a second of the distance in kilometers. There were loads of additional 
astronomical information about our nearest planetary neighbor, far too much to explore in one session, 
but lots of reasons for a return visit for the curious.  
 
Next was “Directions to Starbucks”. I instantly knew the location of all the Starbucks in Sarasota, and I 
had my choice of getting directions by public or private transportation. The application even offered 
directions by bicycle or foot.  
 
In an effort to stump it I asked “How can we get rid of Khadafi?”  Incredibly, the thing gave me an answer 
that might actually work. The Pentagon should be informed.  
 

 
 
Changing Page Margins in Microsoft Word 
(Submitted by Howard Lewis, Midland Computer Club, Midland MI) 
 
Changing the page margin in Microsoft Word is a simple process. Several default margin settings are 
available and you can setup custom page margins if necessary. If you wish to change the margins in your 
Word document, use the following procedure: 
 

(Continued from page 4) 

(Continued on page 6) 
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With your document open, click the Page Layout tab. 
In the Page Setup group, click on Margins and the list of predefined margins appear: 

 
 
Select the desired margins from the predefined list or click on Custom Margins… and set your specific 
margins if necessary 
 

Word will now apply those margins to your document. 
 

 
 
7 Little Word Annoyances and Their Easy Fixes 
By Nancy DeMarte, Columnist, Office Talk, Sarasota PCUG, Inc., FL, ndemarte (at) Verizon.net 
March 2011 issue, Sarasota PC Monitor, www.spcug.org 
 
Below is a collection of frustrating things that ca n happen when using Microsoft Word. These 
annoyances can occur in any version of Word althoug h most are geared to Word 2007 and 2010. In 
Word 2003, the fix-it steps may be different. 

(Continued from page 5) 

(Continued on page 7) 
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Annoyance 1  -- You accidentally press the Caps Lock key on your keyboard before typing a paragraph. 
When you finish, you find everything in capital letters. 
The Fix:  Rather than retyping the whole paragraph, highlight the text, then click the "Change Case" 
button (Aa), located on the Home tab in the Font group. Click "Sentence case" to transform your 
paragraph into normal sentences.  
 
Annoyance 2  -- You create a party invitation with a light blue background (Page Layout tab - Page Color). 
But when you print it, the background is white. 
The Fix:  Office has set Word to not print full page background colors, probably to save users from 
wasting ink. You can, however, make the colored background print. Click the Office button, then Word 
Options -- Display. Put a check mark next to "Print background colors and images," then click OK. Until 
you remove this checkmark, all colored backgrounds will print. 
  
Annoyance 3  -- You're working on a document where you've set the text size to be a fairly small 10 
points. But you find that the text is too small to view comfortably while you're typing. 
The Fix:  Drag the Zoom slider located in the bottom right corner of the Word window to the right to 
enlarge the screen view of the text. When printed, the text will be 10 points no matter how big it appears 
on the screen.  
 
Annoyance 4  -- You find that the spaces between lines of text in your document are wider than you want.  
The Fix:  If all the spaces are wider than expected, you can change the line spacing for the whole 
document at once. On the Home tab, in the Editing group, click Select -- All to highlight all the text. Next 
click the Line Spacing button in the Paragraph group and select 1.0 for single-spacing or one of the other 
choices. 
 

Note: Word will not remove extra space after paragraphs when you choose a line spacing size. 
To remove extra space after a paragraph, select the paragraph before the extra space, click the 
Line Spacing button and choose "Remove Space After Paragraph." A more permanent way to 
create no extra space between paragraphs is to open the Paragraph group dialog box launcher 
(small diagonal arrow) on the Home tab and put a checkmark in front of "Don't add space 
between paragraphs of the same style." 

 
Annoyance 5  -- Every time you type an email or web address into a document, it turns into a clickable 
hyperlink with underlined blue text, even if that isn't your intention. 
The Fix:  The quickest fix is to right click the address and select "Remove Hyperlink." But this is only a one 
time remedy. To remove this action permanently, click the Windows button, then this sequence: Word 
Options -- Proofing -- AutoCorrect Options -- AutoFormat As You Type. Remove the checkmark next to 
"Internet and Network paths with hyperlinks" and click OK. 
 
Annoyance 6  -- You find that as you type, distracting wavy red and green lines show up under words and 
phrases.  
The Fix:  Word is set to check spelling (red lines) and grammar (green lines) as you type. This is another 
Proofing option which comes enabled from the factory. To turn off one or both of these features, go to 
Word Options (Office button - Word Options) and click Proofing. Remove the checkmarks next to "Mark 
grammar errors as you type" and "Check spelling as you type." You can always check spelling and 
grammar after your document is complete by clicking Spelling & Grammar at the left end of the Review 
tab. 

(Continued from page 6) 



Bits and Bytes August 2011 Page 8 

 

 
Several of these fixes involve the settings found in the Options area of the Office 2007 menu 
(File menu in 2010). Options are available for all the Office programs (Word Options, Excel 
Options, Access Options, etc.) These default settings were determined by interviews with 
thousands of people who use Office regularly in the workplace. If you find that the factory 
settings are causing you more trouble than help, changing them is a simple task. All Office users 
should take a personal tour of the Options menus, which resemble this Word Options window 
with the AutoCorrect box open: 

 

 
 
Annoyance 7  -- You often save documents to the same folder which is buried within other 
folders in My Documents. It takes several clicks to find this folder each time you want to open or 
save a document to it. 
Fix 1:  You can find almost any folder on your Windows Vista or 7 computer by typing its name 
into the Start Menu search box just above the Start button. Often it takes only a letter or two 
before the folder appears in the search results. On the downside, you have to do this each time 
you want to open the folder. 
Fix 2:  A way to make any folder immediately available is to add it to the Favorites section of the 
navigation pane. This pane appears on the left side of any explorer window where you are 
viewing, opening or saving files and folders. To make a folder a Favorite, start by creating or 
opening a file, like a document, and click Save As, which opens the Save As dialog box. This 
reveals the navigation pane on the left, showing a list of possible places to save the file. Navigate 
to the folder you want to make a favorite so that it is the last item in the history bar across the 
top. Then right click the word Favorites in the left pane. From the drop down menu, click "Add 
current location to Favorites." Your special folder will now appear in the Favorites list. It will also 
appear in the Favorites list of the other MS Office programs on your computer, such as Excel and 
PowerPoint. To remove a folder from Favorites, right click the folder and select Remove. 
 
Using a computer should be fun as well as useful. Take a few minutes to think what your 
personal computer annoyances are and try to find fixes for them. Customizing your programs 
makes using the computer much more enjoyable and efficient.  
 

 

(Continued from page 7) 
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The Seventh Son of Windows  

Customizing the Notification Area  
By Lee Reynolds, Contributing Editor, Boca Raton Computer Society, FL 
leetutor@exploringwindows.com 
February 2011 issue, Boca Bits, www.brcs.org  
 
Introduction  
The "Notification Area" is that area on the right-hand side of the Taskbar where your system clock resides, 
and probably a large number of other icons. It used to be called, prior to Windows XP, the "system tray." 
Programs just love to install an icon there, to supposedly speed up access to their features. You doubtless 
have a lot of not very useful icons there, which can sometimes be removed by selecting an option or  
preference from the menus of the associated program.  And in XP and Vista, you can right click the 
Taskbar, select Properties from the context menu that scrolls out, click on the Notification Area tab, and 
then perform various operations in order to "hide inactive icons." 
 
Windows 7  
DEFAULT  
This situation has improved a lot in Windows 7. By default, there are only four icons that will appear in 
your Windows 7 taskbar notification area:   
 

The Sound icon (so you can adjust the volume of your speakers or mute them)  
The Network icon (so you can perform maintenance tasks concerning your network connection)  
The Battery icon (if you're running Windows 7 on a laptop) to tell you how much charge is remaining to 

your pc's battery or whether it's charging if you are running your laptop plugged into a wall outlet 
An icon connected with a new Control Panel applet called Action Center 

 
ADDITIONAL  
If you have any other icons in the Notification Area (such as one for your antivirus program, for example), 
they will usually be found by clicking the little upward-pointing carat to the left of the Action Center icon, 
which causes a small popup window to be shown.  If you want to see any of those icons in this popup 
window in your Notification Area instead, you can just drag them down there. 
 
Windows 7 Action Center  
The Action Center icon will normally handle all those notification messages coming from the system when 
some program thinks you need to take an action of some kind. For example: download important updates 
from Microsoft Update, or perform a scan with Windows Defender, or download the most recent antivirus 
data, etc.  
 
In Windows 7 there is now a new Control Panel applet called Notification Area Icons, which takes the 
place of the corresponding tab of Taskbar Properties in Windows Vista, XP, and previous versions.   
 
When you go to that Control Panel applet, you will be shown a list of each of the Notification Area icons, 
and for each one you can use the "list box" next to it to choose one of three possible settings: 
 

• Show icon and notifications  
• Hide icon and notifications  
• Show only notifications 
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Your Computer's  Health – The “Oh Oh” Moment, Part 2 
By Art Gresham, Editor, Under the Computer Hood User Group, CA, 1editor101 (at) uchug.org 
February 2011 issue, UCHUG Drive Light, www.uchug.org 
 
Oops. What The....?   You  know the feeling. Yesterday everything was fine. Today you are wondering 
what happened overnight. What can you do if your computer seems to have suddenly gotten sick? 
Perhaps it was caused by that neat new application, or game, you installed yesterday, or maybe 
something got installed when you visited that website that promised to speed your computer's internet 
access, but when you the page opened it ran a moment and then seemed to hang up with no sense that it 
really did what was expected. Maybe you should not have installed that app/game/utility because it was 
some kind of rogue or worthless program, or worse, and you are now stuck with a sick system.  
 
Don't you wish you could go back in time to last weekend when everything seemed to be running fine? 
Well, you can. Probably. 
 
If you are running a Microsoft Windows ME, XP, Vista or 7 then the System Restore is available to offer 
you protection for many of these kinds of illness, and might be worth checking to see if you can regain 
your computer’s health. 
 
System Restore allows you to roll back most system files, registry keys, and installed programs, the DLL 
Cache folder, local user profiles, and more. When installed, and not disabled (more about that later) you 
may manually create a restore point, or use one of the automatically created points. And it does this 
without affecting your personal files, or data such as e-mail, documents, or photos. We will discuss full 
backups that include your data in a future article. 
 
Also note that in Vista and later versions it has been improved and now uses “Shadow Copy” Technology 
with even more backup capabilities. 
 
So where do you look to see if you have any restore points? You should do this today to be sure it is not 
disabled. Open System Restore by clicking the Start button, clicking All Programs, clicking Accessories, 
clicking System Tools, and then clicking System Restore. Be sure to select “Restore my computer to an 
earlier time,” then click Next. 
 
You will see a calendar of the current month, and several of the dates should be marked in Bold. These 
dates have restore points available, and some may have more than one as shown below. You may have 
multiple restore points for several reasons.  
 
Wikipedia lists the Restore points that are created: 
• When software is installed using the Windows Installer, Package Installer or other  
• installers which are aware of System Restore. 
• When Windows Update installs new updates to Windows.  
• When the user installs a driver that is not digitally signed by Windows Hardware Quality Labs. 
• Every 24 hours of computer use (10 hours in Windows Me), or every 24 hours of calendar time, 

whichever happens first. This setting is configurable through the registry or using the deployment 
tools. Such a restore point is known as a system checkpoint. System Restore requires Task Scheduler 
to create system checkpoints. Moreover, system checkpoints are only created if the system is idle for 
a certain amount of time.  

• When the operating system starts after being off for more than 24 hours.  
• When the user requests it. On Windows Vista, shadow copies created during File Backup and 

Complete PC Backup can also be used as restore points. 
 

(Continued on page 11) 
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Older restore points are deleted as per the configured space constraint on a First In, First Out basis.  
 
[Wikipedia] To begin a restore simply click on the date you want, and then click Next a couple times. Your 
system will restart and hopefully you have healed the patient. 
 
If you do not see any restore points, you might want to check that the process is not disabled. To do this 
in XP you can right click My Computer, open the Properties, and click on the System Restore Tab. There 
you will see a checkbox where you can “Turn of System Restore on all drives. Be sure that is un-checked. 
For Win 7 see the FAQ How do I turn System Restore on or off? 
 
References:  
http://en.wikipedia.org/wiki/System_Restore 
http://windows.microsoft.com/en-US/windows-vista/What-is-System-Restore 
http://windows.microsoft.com/en-US/windows-vista/What-types-of-files-does-System-Restore-change 
 

 
 
Service Packs Explained (and needed) 
By Sandy Berger, Compu-KISS, sandy (at) compukiss.com 
www.compukiss.com 
 
Although most of us still think of Windows 7 as a brand new operating system, it is, in fact, starting to 
show its age. Windows 7 made its debut on October 22, 2009. Is one and one-half really old? Well, in the 
computer world, it is not old, but it is certainly full-grown. One sign of this is that Microsoft has just 
released the first Service Pack for Windows 7. 
 
A service pack is a collection of updates, bug fixes, and enhancements for a software program. As you 
know, Microsoft routinely offers updates for their Windows operating systems.  These updates come out 
weekly and they patch or, you might say, repair the operating system so that they remain safe from 
hackers. They can also include improvements or enhancements to the operating system. At a certain 
point in time, Microsoft gathers all of those updates, adds any other updates and enhancements they 
have and issues this batch of updates as a service pack.  It is also important to note, that when Microsoft 
issues a service pack, this service pack also makes sure that all of the updates and enhancements work 
well together and offer good stability for the operating system. 
 
The question that I am most often asked is this, "If I have installed every update that Microsoft has 
released, do I still need to install the service pack?" The answer is "yes." Often the service pack contains 
additional updates and/or enhancements that were not included in the weekly updates. Also, a service 
pack makes sure that all of the updates are put together properly to make your system run well. 
 
In fact, Microsoft thinks that this is so important that they only support the operating system when it has 
the proper service packs installed. Each service pack should be installed when it is released. If for some 
reason, they are installed all at the same time, each is installed sequentially. 
 
So, for Windows XP you should have Service Pack 3 installed. Windows Vista should have Service Pack 
2, and Windows 7 should have Service Pack 1. To learn what service pack you have installed, just click 
on the Start button, right-click on Computer or My Computer, and then click Properties. You will see the 
service pack listed under the Windows edition. 

(Continued from page 10) 

(Continued on page 12) 
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You can go to the Microsoft website and install a service pack from there, if you happen to be missing 
one. All service packs from Microsoft are free. If you are using Window 7, the new service pack will be 
offered to you through Microsoft's automatic update service. This Windows 7 service pack can take up to 
30 minutes and will re-boot your computer. I have installed Window 7, Service Pack 1 on several 
computers without a problem, but you should be aware that installing a service pack is a big update. 
Microsoft recommends that you back up your computer before installing a service pack. And to be honest, 
you should be backing up your computer anyway. So if you don't have a backup strategy in place, this is a 
good time to implement one. 
 
The newest version of Internet Explorer - IE 9 is now in testing and it is already available for free 
download in a beta version. This is by far, the best version of Internet Explorer that Microsoft has ever 
released. IE 9 won't run on Windows XP; it requires Windows Vista or Windows 7. Although Microsoft is 
not requiring Windows 7 Service Release 1 to install IE 9, it is advisable to install this Service Release 
before you install IE 9. 
 
Service Packs are a fact of life for Windows users. Installing them may be a bit of a pain, but you really 
need them to make sure that your Windows system is secure and stable and that it performs well. 
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